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PowerTeacher gradebook 1.5 
In this course you will explore the features and functions available in PowerTeacher 
gradebook.  This handout will guide you through the training session, but you can 
also use it for future reference. 

PowerTeacher gradebook is a web application that gives you a way to monitor 
student achievement on assignments. It integrates student scores into PowerSchool 
and makes it easy to share information about student progress with students, 
parents and administrators.  

This training session will cover how to:  
• Set up the PowerTeacher gradebook  
• Enter assignments and record scores  
• Set up student groups and analyze classroom achievement trends  
• Print gradebook reports  
• Take attendance 

Getting Started with the Gradebook 
PowerTeacher gradebook will run on any Windows or Mac OS computer with Java 
1.5 installed.  If you wonder whether or not your computer is compatible, check 
with your local PowerSchool administrator. 

Launch the gradebook from PowerTeacher.  Your local PowerSchool administrator 
will give you the Internet address and login information you need for your school.  
For the purposes of this session, your trainer will provide an Internet address and 
login details. 

Activity 1 – Launch the gradebook 
Get the gradebook web application running on your computer 

1. Open a Web browser and enter the Internet address of your server (for this 
class use the one your trainer provides) followed by /teachers in the 
browser address bar. 

2. Enter your username and password and then click Enter. Your local 
PowerSchool administrator will give you your real login information.  For 
now, use the information you trainer gives you. 
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3. Click Gradebook from the menu on the left, and then click Launch 
Gradebook.  It will take a few moments for the web application to start—it 
will be faster after the first time you launch it. 

4. Click OK to open the launchGradeBook Java Web Start file, if that alert 
window appears. (On some browsers, it opens automatically.) If you get a 
message asking whether you should trust the application’s “certificate,” click 
Trust. 

 

Structure of the Gradebook 
The gradebook is divided into six sections. Each section has its own tab, indicated 
by an icon. The following table provides a brief explanation of the icons teachers 
see when they launch the gradebook. 

Icon Description 

Scoresheet Displays the assignments and scores entered for students 

Assignments Displays the details of the assignments you have created 

Students Displays demographic data for each student in the class 

Grade Setup Displays the final grade setup for each term 

Class Content Displays information about the selected course 

Reports Provides an interface to choose and format reports 

The gradebook is so easy to use, it’s ready to go the first day of school. Of course 
there will be items you want to personalize, but it comes ready to go right out of 
the box. As you go through the next activity, you’ll see for yourself how easy the 
Gradebook is to use. 



 

 

 

 

 Copyright © 2008 Pearson  Page 3 

 PowerTeacher gradebook 1.5 

Activity 2 – Creating Assignments 

1. Click the Plus (+) sign next to the Assignment header to open the New 
Assignment pane.  

2. Enter a name for the homework assignment and choose Homework as the 
category. Set a due date, and determine whether you wish to accept the 
default values for score type and points. Choose whether to include the 
homework assignment in the final grade. Enter a brief description.  

3. Click Save in the lower right corner to save the assignment. The assignment 
will appear in the Scoresheet. 

4. Create one more assignment of your choice. 

Activity 3 – Recording Scores 
Record scores for one of the assignments you just created.  

1. Click the Scoresheet tab. 

2. Enter a score for the first student. 

3. Press Return (Mac) or Enter (Windows) to advance to the next student. 

4. When you have finished entering scores, click Save. 

Setting up the Gradebook 
You’ve learned how easy it is to use the gradebook and create assignments, but 
there’s much more “behind the scenes.” The next part of the training session will 
explore how to set up the gradebook so it’s perfect for your use. 

Setting Up Categories 
Categories are used to organize assignments. By labeling an assignment with a 
category name, PowerTeacher gradebook makes it easy to see how student 
performance changes from one kind of activity to another. The gradebook comes 
with four pre-defined category types: Homework, Project, Tests, and Quiz. Teachers 
can add additional categories and/or modify the default categories. 

Activity 4 – Add Categories 
Add two categories to your PowerTeacher gradebook. 

1. The Categories pane is located in the lower left corner of the gradebook 
window. Click the Plus (+) above the list of categories to add a new one. 

2. Give the category a name and an abbreviation. Choose a color. The color will 
be used in the assignment header on the Scoresheet to make it easy to tell 
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at a glance what categories an assignment belongs to. Enter the points 
possible. Choose a number that represents what most assignments in this 
category will be worth. 

Very important! Remember to select “Include in Final Grade” if scores for 
assignments in the category are to be used in the calculation of the final 
grade for the course.  

When this box is not checked, scores won’t be counted.  While you will want 
to consider the scores from most assignments in the final grade calculation, 
it is appropriate to ignore count for a category like “Permission Slips” or 
“Diagnostic Assessments.” 

3. Add a description of the category, if you wish. Click OK to create the 
category.  

4. Repeat to add a second category.  

5. Close the “Edit Assignment Category” box. 

Setting Up Final Grade Calculations 
After teachers create assignment categories, they need to determine how the 
students’ final grades will be calculated for each term, by total points, term 
weights, or category weights. (Another consideration is that the school or district 
may set a policy for how to determine the final grade.) 

Total Points  
This method calculates the student’s final grade by dividing the points the student 
has accumulated by the total number of points possible.  

Total Points is the default setting for all terms and classes. If you want to use a 
different method, you will need to set up each class individually.  

Term Weights   
This method multiplies one term grade by some value (or weight) to calculate a 
grade in a more comprehensive term.  

For example, Semester 1 might be worth 40% of the final grade for the year, and 
Semester 2 worth 60%. (Percents can also be entered as decimals, such as 
33.33%.) 

Category Weights 
This method multiplies the total number of points by the value (or weight) of each 
category. It allows you to set up the weights for each category according to your 
personal plan or school requirements.  
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Activity 5 – Set up Final Grades 
Set up final grade weighting for Semester 1, using Category Weights. 

1. Click the Grade Setup tab, then choose Calculations. 

2. Click the S1 term. 

3. Select category weights. 

4. Click + at the lower left of the Final Grade Setup pane to bring up the Select 
Categories window. Check the boxes for Homework, Project, Quiz, and Test, 
then click OK. 

5. Click in the Weight column and set the value of each category as follows: 

Homework = 1 

Project = 2 

Quiz = 1 

Test = 1 

Notice that percentages are automatically calculated. 

This setup makes the overall grade for projects to be worth 40% of the final 
grade, or twice as much as the grade for any other category. 

6. Enter a 2 in the “Drop Low” column for each category except Project. Leave 
the “Drop Low” value for Project at 0, since it is unlikely that there will be 
very many comprehensive Projects assigned during the term. Click Save. 

Note that when you set up Final Grades for your classes, you’ll want to document 
your grading setup, so that you can explain it to the parents of your students later. 

 

Grade Scales 
Your Instructional Administrators will have set up default grade scales that are 
available for use with your classes. They may also allow you to set up your own 
grade scales and use these for students or groups of students. (In the training 
situation, you have this ability.) 

Activity 6 – Add a grade scale 
1. Click the Grade Setup tab and then click the Grade Scales mode. 

2. Select the Default grade scale and click + in the lower left corner of the 
pane. 
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3. The new grade scale (“Copy of Default”) appears in the lower pane. Change 
the name to Whole Letter Grades. 

4. Add a description: This is a simple grade scale with five values. 

5. Click in the Ignore cell for each + or – letter grade. Notice that as soon as 
you click, a checkmark appears in the column for that grade.  

6. Click Save. 

7. Click the Students tab. 

8. Select the first student. Information about that student will appear in the 
lower half of the window. On the right is a Grade Scale menu: choose Whole 
Letter Grades. 

9. Click Yes in the Grade Scale Changed alert window. 

10.Repeat steps 7-9 for a few more students. 

To view the students in each of your sections assigned to a specific grade scale, 
click the Grade Setup tab. Then select a grade scale, and click the Sections tab in 
the Grade Scale pane in the lower half of the gradebook window. Click + (PC) or 
the triangle (Mac) to the left of the book representing the section you want to view 
to see the list of student names. 

Click the Scoresheet icon to see that the Custom Grade Scale icon  appears next 
to each student who has been assigned to the grade scale you just created. This 
icon is also displayed when viewing final grades.  
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Gradebook Preferences 
Use the preferences window to indicate how you want grades to be calculated, 
stored, and displayed. Also, choose how to distinguish your different sections and to 
turn on the Spell Check feature. 

Find Preferences in the PowerTeacher Gradebook menu (Mac) or the Tools 
menu (Windows). 

To display a unique name for your class sections, click the Section tab in the 
Preferences window and select Custom Display Name. Create the new name in 
the Class Content tab, described below. 

Class Content 

The Class Content tab contains information about and resources for the course you 
selected in the Classes pane. It has three sections: Class Info, School Content, and 
Class Content. 

Class Info 

You can enter text in the Custom Display Name field to personalize your class list. 
Enter text in the Description field to communicate with parents about class rules 
and your expectations of students, or to give an overview of the course and any 
other information that would be of interest to parents. 

School Content 

Your instructional administrators may have filled this section with instructional 
resource files and recommended websites.  

Class Content 

This section is where you can add content and information for your classes.  For 
example, you could add a website you have made for your class, or other websites 
you would like your students to use. You can also add documents like field trip 
permission slips, book report forms, and vocabulary review sheets. 
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Activity 7 – Adding Content  
Practice adding a link that you would like to make available in the parent/student 
portal. Then add additional links to the My Content area.  

1. Click the Class Content tab and then the Class Info mode. Enter the 
following sample information: This semester, we will be studying a 
variety of topics. If you’re ever at a loss for where to find 
high-quality information, feel free to consult the Library of 
Congress  

2. Click +link to the left of the Description area. Paste in this url: 
http://memory.loc.gov/ammem/index.html 

3. Enter American Memories in the “Link Text” field. Select “Open this link in a 
new browser window” and click OK. From the Tools menu, select Check 
Spelling. Click Add to put “you’re” in your custom dictionary, and click 
Ignore for “href” – part of the link address. Click Save on the Class Info 
pane. 

4. Switch to the My Content mode. 

5. Click + in the lower left to open the New Link pane. Enter National Zoo in 
the Name field and http://nationalzoo.si.edu/  in the Address field. 

6. Open the Type menu to see that you can add a variety of resources to My 
Content. In this case, use the default value, Web Site. 

7. Because this is the first link you will have entered, there are not any groups 
to choose from in the Group menu. Add one by clicking + to the right of the 
menu. In the Content Groups window, enter Animals in the Name field. 
Choose a color, and in the Description area enter: These sites contain 
quality information about land and marine animals. 

8. Choose the Animals group for the National Zoo link and click Save. 

9. Click + to add a link to the National Aquarium http://www.aqua.org/ 
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Using PowerTeacher gradebook in the Classroom 

Assignments 
Teachers can set up assignments at the beginning of a school term or at any time 
during the term. The name, point value, and date due for each assignment appear 
above the column in which student scores are entered. Double-clicking an 
assignment heading (or clicking the arrow at the top) opens the assignment 
definition window, where you can modify the assignment or publish it.  

As you enter assignments, you will notice a demarcation line that separates future 
assignments from past assignments. Posting assignments before entering scores 
does not skew how grades appear. The Final Grade that appears next to the 
student’s name on the Scoresheet reflects an average grade for only the 
assignments that have already been scored. 

Publishing Assignments 
Publishing an assignment makes it possible for parents and students to see it in 
PowerSchool Parent Access. By default, an assignment is published as soon as it is 
created. The Publish tab is located behind the assignment pane. 

If an assignment is part of the student’s final grade, it must be published at some 
point. You will receive an error message if you choose the Never publish option for 
an assignment that is to count toward the final grade. 

One advantage of publishing assignments in advance of their due date is that 
parents can see that there are upcoming projects to work on, or tests to prepare 
for, and you can enlist parents to help make sure students do their best. 

Filtering Assignments 
At some point, your gradebook will be filled with assignments, and it might become 
hard to find the one you want.  You can filter what appears in the scoresheet by 
choosing a term in the pull-down menu at the top of the scoresheet. This will allow 
you to see only the assignments due in the chosen term. 

You can also filter by Categories, located in the bottom left of the gradebook 
window.  If you highlight one or more categories and choose Filter Selected, you 
will see only those assignments that are in the categories you selected. 

Activity 8 – Set a Publish Date for an Assignment 

1. Open one of the assignments you created at the beginning of the session. 

2. Click the Publish tab. Choose Days Before Due from the Publish 
Assignment menu. Enter 5 in the Days Before Due field. Click Save in the 
lower right corner to save your changes.  
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Copying Assignments 
You can copy assignments from one class to another by using the Copy Assignment 
item in the Tools menu at the top of the screen.  

Use the Classes menu in the upper left corner of the gradebook window to 
determine which term’s classes to view. By using the Classes menu, you can select 
classes and copy assignments from the past.  

Activity 9 – Copy an Assignment to another Section 

1. Select one of the assignments on the Assignments tab, and click Copy 
Assignment in the Tools menu. 

2. Choose one of your other sections to copy the assignment to. Choose 
Custom from the Due Date menu. Click the calendar icon next to the On 
Date field and click on a date two weeks into the future. Click OK. 

3. Open the class section to which you just copied an assignment. Because you 
were on the Assignments tab in the first class, this class should open to the 
Assignments tab, where you should see the assignment you copied. 

4. Return to the class you had been working on by clicking its name in the 
Current Classes pane. 

Weighting Assignments 
When you create an assignment, use the Weight field to help keep grading 
practices flexible, yet consistent. For most assignments, keeping the Weight at the 
default value of 1.00 and using Points Possible to adjust how the assignment 
contributes to the overall term grade is most appropriate. 

When scoring letter grade assignments, you do not need to be concerned with 
points. Simply enter the letter grade for each assignment. You can use weighting to 
automatically take care of the relative value for each assignment. 

Activity 10 – Weight Assignments 
Use weighting to make each of the three quizzes below worth 100 points, even 
though they contain a different number of questions. 

1. Use information in the grid below to determine the calculated grade value of 
the quizzes. Keep in mind that “Number of points” means how much the quiz 
is worth, not how much each question is worth. 

2. Multiply the Number of Points by the Weighting to determine the value of the 
quiz toward the final grade. 
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Number of 
Questions 

Number of Points Weighting Calculated Grade 
Value in Points 

10 10 10  
20 20 5  
25 25 4  

 

What weighting would you use to make a 50-item test count as 100 points? 

 

Recording Scores 
When entering scores, match the type of score you enter to what you set up when 
you created the assignment; numbers for points and percentage, letters for letter 
grades. You can enter scores individually or by using one of the following quick-
entry methods: 

• To mark an assignment Exempt, type EX into the cell on the spreadsheet. 

• (=) - assign the maximum points possible 

• MI or (/) - mark an assignment missing  

• LT or (*) - mark an assignment late 

• COL or (.) - mark an assignment collected 

• Choose Fill Scores to mass fill a specific score. 

Occasionally, after creating an assignment, you may want to change the Points 
Possible. If you go into the assignment and change the number of points possible, 
then click Save, a warning will appear. You can choose to keep the scores, or have 
the computer adjust them based on the new points possible. 

Activity 11 – Record Scores 
Record scores for a few of the assignments you created. 

1. Click the Scoresheet tab, and then choose Assignments. 

2. Click in the cell representing the intersection of the row containing a 
student’s name and the column of the assignment you want to score. Then, 
enter the score. 

3. Press Return (Mac) or Enter (Windows) to advance to the next student, or 
Tab to advance to the next assignment. Leave a few score cells empty. 

4. Use the Mass fill option for one of the assignments by choosing Fill Scores. 
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5. When you have finished entering scores, click Save. 

6. Click Summary at the bottom of the Scoresheet to see summary statistics 
for assignments.  Clicking Summary again will hide the statistics. 

 

Using the Score Inspector 
Use the Score Inspector to indicate if an assignment was received late, if a student 
is exempt from completing the assignment, if an assignment is missing, or if you 
have collected the assignment without entering a point value. You can also use this 
tool to enter a score comment. The following table provides a brief explanation of 
the assignment indicators displayed in the teacher’s gradebook. 

 

Indicator Description Indicator Indicator Meaning 

Small “c” in blue dot next to 
score 

 There is a comment attached 

Small “L” in red dot next to 
score  

 Assignment turned in late 

Small “M” in orange dot next 
to score  

 Assignment is missing 

Green check in a cell   Assignment turned in but not graded 

Italicized faint score   Assignment does not count toward final 
grade OR was marked as exempt after 
scoring. 

Small Hourglass in 
assignment heading  

 Assignment published on certain date 

Circle with line through it in 
assignment heading  

 Assignment is never to be published 

Small red exclamation mark 
next to italicized final grade  

 Final grade changed by manual override 

Yellow exclamation mark in 
the assignment heading  

 Scores are not published  
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Activity 12 – Score Inspector 
Use the Score Inspector to add score notes, and to mark assignments collected, 
late, and exempt. 

1. On the Tools menu click Score Inspector, and then Assignments. (Or, 
right-click or control-click in the assignment column in the first empty cell to 
bring up the Score Inspector.) 

2. In the Score Inspector, select the Collected box instead of entering a score. 
You can replace the check mark with a score later.  

3. Click the down arrow to move to the next student. Select the Late box. 

4. Click the down arrow to move to the next student. Select the Missing box. 

5. Click the down arrow to move to the next student. Select the Exempt Score 
box for one assignment.  

6. Click the right arrow to move to another assignment. Select your assigned 
student. Enter this comment in the Score Inspector: Student is working 
steadily. 

7. Click down to move to the next student. Click the Comment tab in the Score 
Inspector and click one of the comments in the comment bank to select it. 
Choose Line Breaks from the Separate Using menu, then click Insert 
Selected.   

8. Click Close to close the Score Inspector. Do not click Clear. The Clear button 
clears the score completely, not just the comment or a Collected indicator. 

9. Click the term grade for one of your students. Use the Score Inspector to 
enter a comment. Note the Reporting Term here: 

 _________________________________________________________ (Later 
in the class you will look at your comments in PowerSchool Parent Access.) 

10.Click Close and then click Save to retain the changes. 

Final Grades 
Click the Final Grades mode on the Scoresheet to see how students are doing in 
each of your grading categories. Use this mode to enter a Citizenship grade for your 
students. Notice that summary statistics are available for category grades at the 
bottom of the Scoresheet. 
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Manually Override a Final Grade 
Occasionally, teachers need to modify a student’s calculated final grade in a course, 
based on the student’s effort, participation, or other classroom factors. Use the 
Manual Override feature on the Score Inspector to change a final grade. 

Activity 13 – Manually Override a Final Grade 
Raise a student’s final grade to a value that is higher than was calculated. 

1. Choose the Scoresheet tab and then click Final Grades. 

2. Double-click (or right-click) a student’s final grade to open the Score 
Inspector, and then select Manual Override. 

3. Change the percent and grade. Then, add a comment and click Close. Notice 
that two new indicators appear next to the final grade, a “C” for Comment, 
and an “!” for a changed final grade. 

Completing Final Grades 
Final grades are calculated throughout the term, but at the end of the term you can 
let your PowerTeacher administrator know your grades are complete. By sending 
the notification, your administrator knows it is safe to store grades and send 
reports.  

A Final Grades Completion Status button is located above the student names on the 
Scoresheet. The button states (Term) In Progress until you change it. Click that 
button and select Final Grades Complete.  

Alternatively, if your grades aren’t finished, enter a comment and let the 
PowerTeacher administrator know when your grades will be ready. Click OK to save 
the changes. The Final Grades Completion Status button will state your grades are 
complete. 

Student Groups 
You can use the gradebook to put students into groups.  You may use these groups 
for tracking groups working on projects or for students at different ability levels. To 
do this you need to set up a Group and then Sets within the groups. 

The Groups you set up appear in the center of the left panel. Expand a group by 
clicking on the icon next to it.  You can filter the Scoresheet to show only a selected 
group of students by using this pane.  Click the set or sets you want to see and 
choose Filter Selected from the menu. Then the Scoresheet will show only those 
students.  If you choose Highlight Selected instead, it will show all students in the 
class, but highlight the selected students. 
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Activity 14 – Making Student Groups 
Imagine that you need to divide your students into a few groups. You can use these 
groups when calling parents, assigning books, and scheduling conferences. Call the 
set Class Groupings, and create four groups underneath it. Each group will contain 
students with specific last names, such as students whose last names begin with 
the letters A-F, G-L, M-R, or S-Z. After you create the groups, assign all the 
students to his or her alphabetical group. (Note that a student can be in only one 
group of a specific set of groups. However, she could be in a group in a second set.) 

1. Click the plus (+) sign in the Student Groups filter and choose Add Group 
Set. 

2. Enter Class Groupings as the Group Set Name and click OK. 

3. Control-click Group 1 and choose Edit. 

4. Enter the Group Name A-F and click OK. 

5. Control-click A-F and choose Add Group. 

6. Enter the Group Name G-L and click OK.  

7. Repeat steps 5-6 for groups M-R and S-Z. 

8. Select the first student with a last name that begins with A.  

9. Press the Shift key and select the last name that starts with F. 

10.Drag the group of names to the A-F group. 

11.Repeat steps 8-10 for the G-L, M-R, and S-Z groups. 
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Gradebook Reports 
PowerTeacher gradebook includes a robust set of reports you can use throughout 
the year. You can run reports for one student, a group of students, an entire class, 
or all of your classes.  

The following table provides a brief description of the reports: 

 
Report Name Description 

Attendance Grid Student/date grid template for taking attendance 

Category Total Report Compares the scores students got in each 
assignment category  

Final Grade and Comment 
Verification 

Displays the final grades for students and teacher 
comments by term 

Individual Student Report Displays a summary of the class activity per 
student 

Missing Assignment Displays assignments that are missing per 
assignment or per student 

Scoresheet Displays a copy of the teacher’s gradebook 

Student Multi-Section Report Includes grades from all of a student’s classes 

Student Roster Displays demographic information by class 

 

You can choose to view PowerTeacher gradebook reports on-screen or to print them 
in one of three file types: 

• PDF – a cross-platform file that can be read and printed by Adobe Acrobat 
Reader or Preview on a Mac or PC.  

• HTML – a file that can be read by a browser such as Internet Explorer, 
Firefox, or Safari. 

• Text Export (CSV) – a text file consisting of the data, separated by commas. 
This file can be opened with Excel or another spreadsheet application.  

 
You can personalize each report by entering a custom title or by including an 
introduction in a top note, instructions in a bottom note, and signature line for 
parents. 
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Activity 15--Run an Individual Student Report 

1. Open the Students tab and select one student by clicking his or her name. 

2. Click the Reports tab, and then click Individual Student Report. The 
report options appear in the lower pane on the screen.  

3. Select the PDF Output Type.  

4. In the Sections row, click Selected Class. In the Students row, click Selected 
Groups and/or Students. Click Student Name in the Student Field row. 

5. Click all the boxes in the Include row. 

6. Set the Date Range to the term you have been working in, Q1, for example. 

7. Click the Layout tab. Customize your report by adding the following:  
 
A custom title – Use the name of the student you selected. 
 
A top note – Enter: This report illustrates ______ (student name) ‘s 
progress for Q1. 
 
A bottom note – Enter Please sign and return this document by 
Friday. 
 
A signature line – Click include. 

8. Click Run Report in the lower right corner of the screen. A Report Complete 
window appears. Select Open Report.  

If time allows, explore some of the other reports. 
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Taking Attendance 
You can take attendance for your classes using the PowerTeacher Portal from which 
you launched the gradebook.  When you first log in to the Portal, you will see the 
Start Page, on which a list of your classes appears, with a set of icons next to each 
class. The chair is the first icon and represents attendance. Next to it is a button 
that turns green after you have taken attendance for the day.  The other icons 
represent other functions (lunch counts, information on the students in the class, 
and whole-class reports you can run). 

 

To take attendance, click the chair (if a chair looks faded, it means the class is not 
scheduled for that day, and you can’t take attendance for it). You will see a list of 
students in your class, with an empty box next to each name.  You do not have to 
mark a student present.  If all students are present, just scroll to the bottom of the 
page and click Submit.  You must do this when all students are present, or 
PowerSchool will not know you have taken attendance.  If anyone is not present, 
choose the appropriate code from the pull-down menu and click the box next to 
student’s name, and then click Submit. 

Activity 16 – Taking Attendance 
 

1. Log in with the information you used at the beginning of the class to get to 
the gradebook. 

2. Click on the chair next to one of the available classes. 

3. Select Absent from the attendance code menu.  Click in the box next to a 
student to record that code for them.  Mark someone else absent, too. 

4. Select Tardy from the attendance code menu. Click in the box next to a 
student to record that code for them.  Mark someone else tardy too. 

5. Click Submit. 

6. When you return to the Start Page, notice that the button next to the chair is 
now green. 
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PowerSchool Parent Access 
Parent Access provides parents or guardians round-the-clock access to real-time 
information about their child’s attendance and grades. It also provides a means for 
teachers to communicate with parents or guardians about class events, 
assignments, and ways they can help their child at home. Through Parent Access, 
parents can receive periodic emails containing attendance and grade updates. In 
addition, teachers’ email addresses are listed on the front page. 

To log on to Parent Access, parents need the following information from the 
PowerSchool Administrator: 

• Address of the PowerSchool server 

• A username and password 

Activity 17 – PowerSchool Parent Access 
Log in as a parent and click through the screens in PowerSchool Parent Access to 
become familiar with the information parents can access. Make sure you are looking 
at the same term you were working in and recorded in activity 12. 

1. Click Grades and Attendance. Click the term for the class in which you 
entered assignments and scores. The comment you entered on the term 
grade appears under the table containing the grade information. 

2. Click the score of an assignment for which you entered a comment. The 
comment you entered appears in the score comment pages. 

 


